
INSTRUCTION DU SERVICE SCIENTIFIQUE DU PATRIMOINE
NUMERISATION DES SPECIMENS TYPES

Cette instruction décrit les modalités de numérisation des spécimens types 

Acteur Etape
1 Scientifique 

Conservateur
Gestionnaire de collection

Utiliser selon le choix du conservateur la numérisation par :
photogrammétrie (Agisoft)
focus stacking (Zerene Stacker)
Par scanner à lumière structurée

2 Encodeur
Gestionnaire de collection
Conservateur

Numériser  l'étiquette  ou  les  marquages  sur  la  pièces  permettant
l'identification

3 Encodeur
Gestionnaire de collection
Conservateur

Numériser le spécimen selon les HOW-TO de chaque technique
A) Focus stacking
B) Photogrammetry
C) Structured light HDI

4 Encodeur
Gestionnaire de collection
Conservateur

Sauver les données dans l'un des formats demandés

6 Encodeur
Gestionnaire de collection
Conservateur

Placer le fichier sur virtualcollections.naturalsciences.be si le document est
destiné à être publié ou sur MARS si il doit rester privé.
Réaliser un copie sur un disque dur de backup long terme.
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INSTRUCTION DU SERVICE SCIENTIFIQUE DU PATRIMOINE
NUMERISATION DES SPECIMENS TYPES

A) Focus stacking

Acteur Etape
1 Scientifique 

Conservateur
Gestionnaire de collection

Before  switching  on  the  StackShot  Controller  by  connecting  it  to  the
Electrical network, make sure the following steps are ok:

 The camera is connected to the Stackshot controller (Shutter cable)
 The StackShot controller is connected to the StackShot Rail
 The camera is connected to the PC

All ok? Plug in the StackShot Controller
2 Encodeur

Gestionnaire de collection
Conservateur

Switch on the camera
 Open 'EOS Utility'
 Select 'Camera settings/Remote Shooting'

Now the window appears to select your camera settings etc. Follow further
instructions

3 Encodeur
Gestionnaire de collection
Conservateur

Switch on the light inside the closet

4 Encodeur
Gestionnaire de collection
Conservateur

Switch on 'Live View Shoot' (Bottom left in the EOS Utility window)

5 Encodeur
Gestionnaire de collection
Conservateur

Set the Shutter speed on 'BULB' (click on the shutter speed and press ↓)

6 Encodeur
Gestionnaire de collection
Conservateur

Set the power of the speed lights: if you use a Grey Background
 ½ or ¼ for 3x to 5x magnification
 1/8 to 1/16 for 1x to 3x magnification
 1/32 or 1/64 for regular macro lenses

test if the flash lights work by pressing the remote
7 Encodeur

Gestionnaire de collection
Conservateur

Place the specimen in the closet in the centre of the lens

8 Encodeur
Gestionnaire de collection
Conservateur

If you use the MP-E 65 mm Macro Photo, set the approx. desired 

Magnification Sensor filling size

1x 22.5 mm

2x 11.3 mm

3x 7.5 mm

4x 5.6 mm

5x 4.5 mm

9 Encodeur
Gestionnaire de collection
Conservateur

Make sure that 'Mode: Auto-Dist' is selected on the StackShot controller, if
not press 'up' or 'down' on the controller till it appears.

10 Encodeur
Gestionnaire de collection
Conservateur

Move the camera up or down by pressing 'Fwd' or 'Back' till the specimen is
in-focus (Confirm through Live View in EOS Utility).

11 Encodeur
Gestionnaire de collection
Conservateur

Set  the  distance  the  camera  needs  to  travel  between  each  picture  by
pressing  'select'  once  and  'up'  or  'down'  to  increase  or  decrease  the
'Dist/Step'. Guidelines for the Step Size:

Magnification Step Size

1x 150 µm to 300 µm
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2x 120 µm to 200 µm

3x 75 µm to 150 µm

4x 50 µm to 80 µm

5x 30 µm to 60 µm

Normally you'll end up with a stack of 15 to 40 pictures for the mean values.
12 Encodeur

Gestionnaire de collection
Conservateur

Set the appropriate f-stop and speed light power
 1:1 to 1:10 f/5.6 to f/7.1, flash 1/16 to 1/64
 3x to 5x magnification f/4.0 or f/4.5, flash ½ nd or ¼ th
 1x to 3x magnification f/4.5 to f/5.6 flash 1/8 th till 1/16 th
 Press test shooting in the Live view window, a new window appears
 close the Live View window, otherwise the speed lights won't flash
 press the white squared button upper right
 alter the f-stop and/or flash power

13 Encodeur
Gestionnaire de collection
Conservateur

Select the upper most part of the specimen by travelling upwards
 press 'Back' on the controller till the entire specimen is out of focus
 press 'Fwd' till a part (the upper most part), is in focus
 press 'up' or 'down'
 'Select End Pos' appears

14 Encodeur
Gestionnaire de collection
Conservateur

Select the most distant part
 Press 'Fwd' on the controller till the entire specimen is out of focus
 Press 'Back' till a part (the most distant) is in focus
 Press 'up' or 'down'

15 Encodeur
Gestionnaire de collection
Conservateur

Close Live View window and check again if the speed lights work (press the
button of the transmitter on the camera)(Transmitter: TX; Receiver: TRX)

16 Encodeur
Gestionnaire de collection
Conservateur

Select the folder to save the pictures and make sure you take both RAW
and Large pictures if desired.

17 Encodeur
Gestionnaire de collection
Conservateur

Press the 'Up' or 'Down' button to start the process of taking pictures

18 Encodeur
Gestionnaire de collection
Conservateur

Open Zerene Stacker (not the safe mode)

19 Encodeur
Gestionnaire de collection
Conservateur

Press 'ok' on the welcome screen

20 Encodeur
Gestionnaire de collection
Conservateur

Click 'add files' in the 'File' menu
Select all the images in the selected folder
press 'add'

21 Encodeur
Gestionnaire de collection
Conservateur

In the 'Stack' menu select one of the following parameters:
 Align and Stack PMax
 Align and Stack DMap
 Align and stack both

it is possible to stack without aligning by selecting the images in the 'input'
window and select 'Stack selected (PMax)' or 'Stack selected (DMap)' in the
Stack menu

22 Encodeur
Gestionnaire de collection
Conservateur

After the stacking process is done, select all the out files and press 'Save
output images' in the 'File' menu.

23 Encodeur
Gestionnaire de collection
Conservateur

Click on ‘Show batch dialog’ in the Batch menu tab (a new window appears).
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24 Encodeur
Gestionnaire de collection
Conservateur

In the Batch Queue window the left part is to select folders and to choose
what to do with project files. The right part is to decide how to stack and safe
the stacked images.

25 Encodeur
Gestionnaire de collection
Conservateur

LEFT:  Click  on  ‘Add  Projects  and  Folders’  and  select  the  folders  to  be
stacked  (important  each folder  is  one view).  Decide  to  Save  the  project
folders in case of type material.

26 Encodeur
Gestionnaire de collection
Conservateur

RIGHT: Click on ‘Add’ and Select ‘PMax’ and ‘DMap’ (Align and Stack) and
press OK

27 Encodeur
Gestionnaire de collection
Conservateur

Select ‘Save in Source Folders’ and Press ‘Run all Batches’. You can close
the Batch Queue Window.

28 Encodeur
Gestionnaire de collection
Conservateur

If you want that automatically the name of the folder is saved as name for
the stacked image, do as follows:
Open the ‘Preference’ submenu in the ‘Options’ menu and choose ‘Image
saving’. Below you find ‘Output Image Names’ and write the following in the
space below:
{sourcefolder} ZS {method}
Press on ‘Apply’ and OK

Trouble Shooting

The stack process (picturing) 
is started, but there aren't any 
pictures taken by the camera.

 Check if the shutter cable is well connected to the camera and the
stackshot controller

 Check if the light of the Stackshot is blinking when a picture should
be taken

 Check if the 'Live Shoot' from the EOS Utility window is closed
The stacking process is 
started, but the flash lights do 
not respond

 Check if the 'Live Shoot' from the EOS Utility window is closed
 Check if the batteries of the flashes and the transmitter/receiver are

charged
 Check if the trasmitter (Yongnuo RF603CII) is set in TX position and

the receiver in TRX position
The pictures taken fluctuate in 
light intensity, some are well 
exposed, others are too dark.

 The batteries of the flash working in 'Slave-mode' (S1) are low in
power. Change batteries, preferably of both flashes.

 In case you do not have spare batteries, make the time in between
2  pictures  longer  (config)  to  give  more  time  to  recharge  the
batteries.

Some pictures are black, 
others a well lit.

 Check the batteries of the flash with the receiver on it. It is possible
the batteries are without power, so recharge them.

 It is possible the batteries of the receiver are low.
 It is possible that only the transmitter is low on energy, change the

batteries of the transmitter or receiver if  changing the batteries of
the flashes didn't improve.

During stacking with Zerene 
stacker, there is a warning that
the selected file doesn't 
contain any pictures.

The folder selected in the batch process is empty. 
 Check the other files for the pictures, it is possible that you saved

your  pictures  in  another  folder  while  taking  pictures.  Add  the
pictures to the empty folder; Remove all successful stacked folders
from the list in the batch process and restart it.

 It  is  possible  the  wrong  folder  is  selected  in  the  batch  process.
Remove  this  folder  in  the  list  together  with  the  ones  that  are
successfully stacked and add the correct folder and restart the batch
process

B) Photogrammetry

Acteur Etape
1 Scientifique 

Conservateur
Make 3 sets of 36 views of the specimen
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Gestionnaire de collection
2 Encodeur

Gestionnaire de collection
Conservateur

Import picture(s) in Agisoft

3 Encodeur
Gestionnaire de collection
Conservateur

Mask
 create a mask with photoshop/gimp and use automatic masking if

smooth background + check mask 
 manual masking (lasso or lasso+ctrl)

4 Encodeur
Gestionnaire de collection
Conservateur

Align picture
 Delete picture with dot out of the point cloud

5 Encodeur
Gestionnaire de collection
Conservateur

Create dense point cloud

6 Encodeur
Gestionnaire de collection
Conservateur

Create model
 cleaning the model with the gradual selection or lasso if necessary
 close hole if necessary

7 Encodeur
Gestionnaire de collection
Conservateur

Create texture (4096x4096)

8 Encodeur
Gestionnaire de collection
Conservateur

Export in the wanted format
DAE for Surface and texture for Meshlab and Unity
PLY for Surface and texture for Meshlab
STL for surface for Meshlab, Gom Inspect and LhP FusionBox 
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C) Structured light HDI

Acteur Etape
Scientifique 
Conservateur
Gestionnaire de collection

1. Calibration

 Depending on the object size, choose camera position.
 Open FlexScan 3.3, in the tab « scanner », choose « Remove » and

delete the previous HDI calibration.
 Create a new HDI Advance.
 On the left part of the screen, select cameras.

! The first camera is the second on the list !

 Position  the  calibration  back-sided  (white)  and  display  the  focus
pattern (right part of the screen). Move the calibration plate until the
black cross is approximately in the centre of both cameras.

 Focus the projector so the focus pattern is sharp.
 Turn the calibration plate with  the checker pattern in front  of the

camera. Focus the cameras.
 Place  the  calibration  plate  in  front  of  the  camera  1  and  start

capturing the pattern according to the schema.  Then do the same
with the second camera.

 Press  calibrate.  Your  calibration  coverage  should  be  superior  to
65 % otherwise start again.

Encodeur
Gestionnaire de collection
Conservateur

2. Scanning

 Place the object in the centre of the turntable.
 Display the focus pattern and check the black cross is in the centre 

of the camera red cross.
 Take out the object. Place the calibration plate, calibrate the 

turntable (press « Recalibrate » under the scan menu).
 Put back your object, check colour texture if required, choose the 

numbers of scans wished (advice number of scans : 8). Uncheck 
« automatic combine »  and press scan.

 Unlock the scans and clean if necessary. To clean, select the 
unwanted part maintaining the Ctrl button pressed and delete.

 Once cleaned, select the scans and press combine. Once combine 
hide the model by clicking off the check-box next to the thumbnail.

 Turn your object on another side and press scan again.
 Clean and combine.
 Display the previous rotation by clicking on the check-box next to 

the thumbnail. With Alt button press, align roughly the two combined
scans together and press align.

 Combine
 Repeat this operations until having a full model.
 When your full model is combine, press finalize.
 Rename the model and export.

! Don't forget to fill out the data-sheet next to the scanner, the parameters of
the scan!

Encodeur
Gestionnaire de collection
Conservateur

3. Shortcuts

Alt+LMB = rotate selected scan
Alt+CMB = Translate selected scan
Ctrl+LMB = select parts of the scan
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Encodeur
Gestionnaire de collection
Conservateur

4. FAQ

 Cameras are not working properly

Case 1 - Restart computer and unplug/replug the cameras

1) Close the software and try to disconnect the power of the 
cameras, and plug it back in. Restart the software. (You may want to
try that several time in a row)

2) Restart the computer

3) After re-plugging if issue didn't go away, please try case 2.

 
Case 2 - Reset all the camera settings.

1) Open FlyCap2 > Configure Selected > Advanced Camera 
Settings > Memory Channel drop down list > select Default, and 
click on the restore button. From the drop down, then select memory
channel 1 > Save. Memory channel 2 > Save.

2) Close this settings Windows. Open FlexScan3D to see if you are 
still seeing the split issue. Also, it might be good to verify if from 
FlyCap by opening FlyCap2 > select the camera, and click on "OK". 
This will generate a live video from FlyCap. If it's not showing up, 
please go into settings > Trigger / Strobe tab > check the "Enable 
/Disable Trigger" check box. Check to see if your video is still split in
half. If you are seeing a black screen but see the the Framerate and 
the Timestamp running on the left hand side, then please change 
the aperture on the lens to make it brighter.

3) If you don't see the video splitting in half, then please continue 
with step 4. Otherwise please skip to case 2.

4) Go to camera settings > set the "Gain" to 0, "Shutter" to 16.66. 
Uncheck all the check boxes.

5) Go to Advanced camera settings > save these settings to 
memory channel 1 and 2.

 I have combine misaligned scan, can I undo ?

« Undo » button or Ctrl+Z doesn't work, but you can uncombine and
recombine. 

! When uncombining, you are not going back to the previous step 
but all the scan are uncombined !

Tip : Recombine by chunks of the number of scan of your rotation.
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